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Notices about this User's Manual
Carefully read this manual so that you can properly use this product.
T&D Corporation accepts no responsibility for any malfunction of and/or 
trouble with this product or with your computer that is caused by the improper 
handling of this product and will deem such trouble or malfunction as falling 
outside the conditions for free repair of the attached warranty.

 - All rights of this user's manual belong to T&D Corporation. It is 
prohibited to use, duplicate and/or arrange a part or whole of this 
user's manual without the permission of T&D Corporation.

 - Microsoft and Windows are registered trademarks of Microsoft 
Corporation in the United States ands/or other countries. 

 - Company names and product names are trademarks or registered 
trademarks of each company.

 - Specifications, design and other contents are subject to change 
without notice.

 - On screen messages in this manual may vary slightly from the actual 
messages.

 - Please notify the shop where you purchased this product or T&D 
Corporation of any mistakes, errors or unclear explanations in this 
manual. T&D Corporation accepts no responsibility for any damage or 
loss of income caused by the use of our product.

 - This product has been designed for private or industrial use only. It is 
not for use in situations where strict safety precautions are necessary 
such as in connection with medical equipment, whether directly or 
indirectly.

 - We are not responsible for any malfunction or trouble caused by the 
use of our product or by any problem caused by the use of 
measurement results of our unit. Please be fully aware of this before 
using our product.

 - Some of our products, which come under the category of strategic 
goods in foreign trade law, need the permission of the Japanese 
government to be exported outside of Japan.

 - The Manual itself can be downloaded from our Web Site at 
https://tandd.com/ .

Software User Agreement 

Disclaimers
 - T&D Corporation does not guarantee the operation of "T&D Recorder 
for Windows TR-5,7xU".

 - T&D Corporation shall not accept any responsibility for any damage, 
whether direct or indirect, that results from the usage of "T&D 
Recorder for Windows TR-5,7xU".

 - Specifications of "T&D Recorder for Windows TR-5,7xU" may be 
subject to change and service may be terminated without advance 
notice to the user. In such a case, T&D Corporation shall not be 
responsible for any damages, whether direct or indirect, from the 
inability to use "T&D Recorder for Windows TR-5,7xU".

 - T&D Corporation has no obligation to correct any defects found in 
"T&D Recorder for Windows TR-5,7xU".

Copyright
1. The Copyright for T&D Recorder for Windows, including the program 

and relevant documents, belongs solely to T&D Corporation.
2. "T&D Recorder for Windows TR-5,7xU" is for use free of charge. 

Redistribution is permitted as long as it is to others for non-profit. In 
this case, all terms and conditions as written in the disclaimers 
automatically transfer and hold true and valid for the party to which 
the program was redistributed. Please note that if you wish to 
commercially redistribute the program please see item 3 below. 

3. The reprinting or redistribution for commercial purposes whether in 
part or in whole, in magazines or as a part of any product is strictly 
forbidden without the expressed consent of T&D Corporation. Any 
inquiries concerning commercial redistribution should be directed to 
your local distributor or T&D representative. 

4. Please do not attempt to make any changes or modifications to "T&D 
Recorder for Windows TR-5,7xU".

https://tandd.com
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Considerations when using this software
This manual covers the operation of the current products (TR-73U and 
TR-5i Series).
For the compatible device list (including discontinued models), please 
refer to the software page of our website.

https://tandd.com/software/tdrec-trxx.html

Cautions about Data Storage Location
When the storage location of downloaded files is the "Program Files (x86)  " 
folder, the files may be saved in the user’s AppData folder due to the virtual 
store function of Windows OS.
Example:
Storage Location Setting
C:\Program Files (x86)\T&D Recorder (TR-5,7xU)
Actual Storage Location
C:\Users\(User Name)\AppData\Local\VirtualStore\Program Files (x86)\T&D Recorder 
(TR-5,7xU)

 * If you are running a 32-bit operating system, the "Program Files" folder will be 
used instead of "Program Files(x86)".

Note: The AppData folder is a hidden folder. If it is not displayed, do the 
following to make it visible.
1. Right-click the Windows Start button and select [File Explorer].
2. Select the [View] menu > [Show], and check the [Hidden items] option.
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Getting Ready
What is "T&D Recorder for Windows 
TR-5,7xU"?

An Overview
"T&D Recorder for Windows TR-5,7xU" is a software program that enables 
you to easily make recording settings for our Data Loggers, download 
recorded data from the loggers, and then process that data into graphs, 
tables and/or save that data to files or print. Upon opening "T&D 
Recorder for Windows TR-5,7xU", a launcher program will appear with 
several icons lined up. By clicking on an icon, a settings / communication 
display for the selected type of device or a graph display will appear.

Basic Functions 

Recording Settings
Settings can be made for recording conditions such as channel name, 
recording interval, and recording mode. By making a recording start (date and 
time) setting in the main unit(s), the unit(s) will begin recording at that time on 
that date.

Data Download
Recorded data can be downloaded from the loggers to your PC.
Note: For the TR-5i Series, it is necessary to separately purchase a 
Communication Port TR-50U2.

Possible to use with a mixture of device types (TR-5i Series, TR-73U)
It is possible to process recorded data from a mixture of device types. 

This manual has been written using ºC as the standard unit of temperature. 
User's in the United States and elsewhere who would like to change the 
unit to Fahrenheit, can easily do so by making changes in the "Shift Unit" 
under "Editing the Graph".

Basic Procedures 

IMPORTANT: 

To make sure that the USB driver is properly installed, please follow the correct 
procedure as outlined here. 

Installing the software
see P.6,

Please follow the directions to install "T&D Recorder for Windows TR-5,7xU" .
Information on OS compatibility is available on the Software page of our 
website at https://tandd.com/software/ .

Connecting the device
For TR-73U: see P.10, For TR-51i/52i/55i: see P.11

Enable communication by connecting the Data Logger / Data Collector or 
Communication Port to the computer with a USB cable. 
Once the USB cable is connected, the USB driver will automatically be installed. 

Making Recording Start Settings
For TR-73U: see P.14, For TR-51i/52i/55i: see P.22

IMPORTANT: 

Before making [Record Start] Settings make sure that your computer clock settings are 
correct. If your computer's clock is not correct, it will effect the date and time of the 
recording start.

Downloading Recorded Data
For TR-73U: see P.16, For TR-51i/52i/55i: see P.24

Before downloading it is possible to make settings in the [Detailed Settings] to 
specify the what kind of processing should be done with the data after 
downloading, i.e. open a Graph or assign a file name and save. 

IMPORTANT: 

Before making Downloading Data make sure that your computer clock settings are 
correct. If your computer's clock is not correct, it will effect the date and time of the 
data being downloaded.

https://tandd.com/software/


Getting Ready6 Getting Ready 7 

Installing the Software 
Download "T&D Recorder for Windows TR-5,7xU" and "T&D Graph" from 
the T&D Website and install to your PC.

https://tandd.com/software/
After installation, "T&D Recorder for Windows TR-5,7xU" and "T&D Graph" 
will appear in the Windows Start Screen or Start Menu.

- If you have no internet access or prefer to install using a software DVD, “T&D 
Software SO-TD1” is also available as an option. 
Please contact your distributor for details. ( https://tandd.com/purchasing/ )

- For details about operations please see the “Help” menu in the software.

T&D Graph
T&D Graph is a user-friendly Windows software which brings users effective 
tools for the management and analysis of data recorded by T&D Data 
Loggers. It contains a variety of useful functions including the ability to read, 
merge, display, and save multiple recorded data files* regardless of the 
model.

 * Note: RVR-52 event data is not supported.
If the downloaded data file is not associated with T&D Graph, refer to "Troubleshooting" 
on P.36.

Operating the Software 

Opening the Software
Open the program from “T&D Recorder for Windows TR-5,7xU” in the 
Windows Start Menu or Start Screen.

Launcher Window
Upon opening "T&D Recorder for Windows TR-5,7xU", a launcher window 
in which icons are displayed will appear. By clicking an icon, the graph, 
settings, and/or communication screen for that type of unit will be 
displayed.

Menu Bar
[Commands are contained in the Start menu, Date Display menu, and Help 
menu.

Icons
By clicking on an icon, the graph or communication display will appear for that 
type of unit. The graph and communication displays for each type of unit can 
also be viewed by clicking on that unit's type name in [Start] of the [Menu] 
Bar.

Quick Start (TR-73U / TR-50U2) 
When Windows is started, the [Quick Start] will be automatically started. 
When a TR-50U2 or TR-73U Series device is connected to your computer, 
the Quick Start will make a search and automatically open the 
application.
Please see below for how to quit the Quick Start function and how to 
restart it again.

Quitting from the Taskbar
	. Click the Quick Start icon in the Task tray to view the popup menu; in 

the popup menu click on [Quick Start Settings] . 

2. Place a check next to [Do not use “Quick Start] and click the [OK] 
Button.
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Re-start from the Start Menu or Start Screen
In the Window’s Start Menu, from the list of programs click on [T&D Recorder 
for Windows (TR-5,7xU)] - [Quick Start] to restart the application. In the Start 
Screen, click on [Quick Start] directly. . 

Quit / Start from each application
	. Click on one of the icons (TR-73U, TR-51i / 52i or TR-55i) in the 

Launcher Window. 

2. Click [Software Settings] in the [Settings] Menu.

3. Remove the check mark from next to [Upon Connecting a Thermo 
Recorder, open the software program.] 
With no checkmark: Quick Start will be disabled  
With a checkmark:   Quick Start will be enabled

	. Click the [OK] Button.

Help
Detailed information on the software can be found in the Software Help 
Menu.
See the [Help] Menu of the software for more detailed information about 
how to use the software.
To search for unclear words or terms, click the [Help] Menu that appears 
in the [Menu] Bar and then click on one of the tabs [Contents], [Index] or 
[Search].

[Contents] Tab
By clicking the mark of the classified topic, an explanation will be displayed.

[Index] Tab
Select a key word from the key word list and by clicking the [Display] Button, 

the explanation will be displayed.

[Search] Tab
Enter the key word you wish to search for and click the [Start Search] Button 
and the topic in which the key word is included will be displayed. Then select 
the topic and click the [Display] Button to have the explanation displayed.

- Click on the [Help] Button in any dialog box and explanations about the dialog box will 
be displayed.

- In the graph display window, after clicking on the [ ] in the toolbar, you can click on 
any Menu, any Icon, or any part of the Main window and an explanation will be 
displayed.

“Help for Unit Recognition Failure”
This contains information about how to check whether the USB driver has 
been properly installed.

About "T&D Recorder for Windows"
This shows the Version Info for the software.

Date Display Format Settings: [Date Display] Menu
The date format chosen will be applicable for all sections of the software 
including graphs and setting displays. 

	. In the [Date Display] Menu, select [Format Settings] . 

2. Check either [Month / Date / Year] or [Date / Month / Year] .

3. By clicking the [OK] Button, the setting will be completed.
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Connecting the Data Logger to the Computer

For TR-73U with USB Communication
Connect the TR-73U to your computer with the USB Communication 
Cable (US-15C).
If necessary, serial communication can be established by using our TR-73U 
communication protocol (contact your local distributor) to write a software program. In 
this case, it will be necessary to connect to your computer using our optional serial 
communication cable (TR-07C). Please contact your local provider for more details.

IMPORTANT:
- If the place of connection is incorrect, communication will not occur. 
- To ensure proper communication, make sure that the communication cable 

connection is secure.

For TR-5	i/52i/55i with Optical Communication
	. Connect the Communication Port (TR-50U2) to your computer using 

the provided communication cable.

2. Place the Data Logger on top of the Communication Port device as 
shown in the figure, making sure that the optical communication 
spots are aligned properly.
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Basic Function for TR-73U
TR-73U: Display Names and Functions

Toolbar

Device and
Device  
Properties

Menu Bar

Settings
Tab

Menu Bar
Commands are contained in the File menu, View menu, Communication 
menu, Settings menu, and Help menu.

Toolbar
The commands that are used most frequently have been arranged as buttons.

Device and Device Propertie
TR-73U connected to the computer by USB cable will be displayed as icons 
and information here. In order to make recording settings or download 
recorded data, it is necessary to first select a device from the device list.

Settings Tab
By clicking on the [Download Recorded Data] Tab or the [Start Recording] 
Tab, you can open the settings display for that function.

Setting Up the Communication Port  
(TR-5i Series)
Settings for both USB and serial port  can be made from the same 
window. It is also possible to confirm current communication settings. 
IMPORTANT:
- When using TR-73U, it is not necessary to make COM Port Settings. 
- When using USB, the USB driver must be properly installed for USB communication to 

properly work. 

	. Connect the device to your computer via USB cable.
2. Open the appropriate application for the type of device being used.
3. In the [Communication] Menu open [Communication Port Settings]. 

For an Automatic Search
Check "Communicate via USB", and click the "Auto Detect" button.
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TR-73U: Starting Recording
Connect a TR-73U to your computer so that communication can occur. 
Please make sure that your computer clock settings are correct.

[Start Recording] Tab
IMPORTANT: 
- Please see P.10 for more information about how to connect. The first time you 

connect it is necessary to install the USB device driver. 
- Before making [Record Start] Settings make sure that your computer clock settings 

are correct. If your computer’s clock is not correct, it will effect the date and time of 
the recording start.

- Note: By starting a new recording session, all stored data will be deleted from the 
device.

Recording Start Date / Time 
Selections from: Programmed Start / Immediate Start
Programmed Start: Recording will start on the specified date and time. 
Immediate Start: Recording will start immediately upon completion of 
    settings. 
Recording interval 
Select from: 1, 2, 5, 10, 15, 20, 30 seconds 1, 2, 5, 10, 15, 20, 30, 60 minutes

Recording Mode 
Selections from: One-time / Endless
One-time:  When the possible number of recorded data readings (8,000 

readings per channel) is reached, recording stops.
Endless:    When the possible number of recorded data readings is 

reached, the oldest data is overwritten and recording 
continues.

Device Name / Channel Name
Make settings for each data logger concerning the device names and channel 
names.
Device Name:  Up to 32 characters 
Channel Name: Up to 16 characters 
[Start Recording] Button
Click to send the settings to the data logger and start recording. Once the 
recording has started, disconnect the device from the PC and place it at the 
measurement location.

[Stop Recording] Button
Clicking this Button will stop a recording session already in progress.

[Receive Settings] Button 
Clicking this will allow you to view recording condition settings and recording 
status information from the data logger.
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TR-73U: Other Functions 

[File] Menu
Open Temp / Humidity Graph
Opens the Temperature / Humidity Graph.

File Names and Folders
Specify how you wish the files to be named upon downloading recorded data. 
Also you can select in which folder to use to save data for each device.

	. Check which type of file name you wish to use to save data.
Default File Name Settings 
Example:
Device Name: Refrigerator / Serial No.: 00001234 / Date and Time: 
2023/05/12(yyyy,mm,dd)at 14:30:15 / with Data Format Extension: TRX

Device Name+Date / Time:
Internal ID+Date / Time:
Device Name+ Internal ID+Date / Time:
Date / Time+Device Name:
Date / Time+Internal ID:
Date / Time+Device Name + Internal ID:

Refrigerator_20230512_143015.trx  
00001234_20230512_143015.trx 
Refrigerator_00001234_20230512_143015.trx
20030512_143015_Refrigerator. trx 
20230512_143015_00001234.trx  
20230512_143015_Refrigerator_00001234.trx  

2. Click the name of the device and then click the [Select Folder] Button.

3. The [Browse Folders] dialog box will appear where in you can select 
the folder into which you wish to save the data, then click [OK].

	. A [Data Folder] will then appear under Device Properties in the Main 
Window.
The default setting will create and save data to a folder with the device's 
serial number in the same folder where T&D Recorder for Windows was 
installed. 

[View] Menu
Large Icon / Small Icon: 
Changes the icon size in the Device List between large and small.

TR-73U: Downloading Recorded Data
Connect a TR-73U to your computer so that communication can occur.

[Download Recorded Data] Tab
IMPORTANT: 

Before making Downloading Data make sure that your computer clock settings are 
correct. If your computer’s clock is not correct, it will effect the date and time of the 
data being downloaded.

[Download] Button
Click the [Download] Button to begin downloading data.

[Detailed Settings] Button
Make settings about how to process downloaded recorded data. If you wish to 
automatically display the graph upon the completion of downloading, click the 
[Detailed Settings] Button to make such a setting.

Graph Display Settings
By checking here, the graph for the downloaded data will automatically 
appear after downloading is completed. 
If the number of channels exceeds 8, it cannot be displayed 
automatically.
Please open from a data file or use T&D Graph.
File Name Settings
You can choose to save downloaded data using a default file name or 
by assigning a name each time. 
You can specify the type of default file name under [File] – [File Names 
and Folders]. For more information about [Detailed Settings] see next 
page.
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[Settings] Menu
Device Name Settings
Device Name and Channel Name can be changed without starting recording.

	. Enter a name.
Device Name: up to 32 characters 
Channel Name: up to 16 characters

2. By clicking the [Send Settings] Button, the changes will be 
completed.

LCD Display Settings
Settings can be made for the Thermo Recorder's LCD display, such as, 
changing the temperature unit and turning the display on or off.

Temp. Unit in Display
Check either Celsius or Fahrenheit.
By clicking the [Send Settings] Button, the changes will be completed.
LCD Display Pattern
You can select from 4 patterns:  
Alternate display among Ch.1, Ch.2 and Ch.3, Display Ch.1 only, Display 
Ch.2 only or Display Ch.3 only.

[Communication] Menu
Monitor Current Readings
You can monitor at set intervals the current readings of Data Logger or 
loggers selected from the device list and have those readings displayed.

[Settings] Button
This opens a window where settings can be made for the display colors 
and the monitoring interval for current readings.
[Close] Button
Quit the Monitoring of Current Readings.
[Reset] Button
Click to reset the display for highest and lowest measurements; the 
new display will show highest and lowest measurements from the time 
of resetting.
[Graph] Button
Click this to hide or view the graph.
[Clear] Button
Clicking this will clear the graph and a new graph will be drawn from 
that point.

Search for TR-73U
If a TR-73U is connected, but does not show up in the Device List, click this to 
search for Thermo Recorders by scanning the USB ports.
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Adjustment Settings
By setting adjustment values beforehand, you can record and display the 
post- adjusted measurement values. 

IMPORTANT:
- We cannot guarantee that after carrying out adjustment the measuring accuracy will 

improve for all measuring ranges.
- If you want to make adjustments to a sensor that has already been adjusted, initialize 

the setting first.
- When a sensor is replaced, it is necessary to re-make any desired adjustment settings 

before using the new sensor.
- When you are carrying out adjustments and formulating equations, please take care 

with the settings and take personal responsibility for the process. 

	. Open Adjustment Settings from the [Settings] menu. Check the 
channel you wish to adjust.
Note: The recording needs to be stopped first.

2. Place a checkmark next to either [1 Point Adjustment] or [2 Point 
Adjustment] and enter the [Before] and [After] values. 
Refer to the Adjustment Guidelines on P.34.

3. By clicking the [Send Settings] Button, the adjustment settings will 
be completed.
You can check the settings log at the bottom of the settings window. The
current Adjustment setting values will also appear in the main window in the
TR-73U’s properties box.

[Initialize] Button
This returns the control settings back to their original factory default settings.

[Save File] Button
Assign a name to the adjustment setting values and save them to a file.

[Read File] Button
Read adjustment setting values from a saved file.

Software Settings
General software settings for TR-73U  can be made here.

Upon connecting a Thermo Recorder, open the Software Program
This setting opens the software program upon the connection of a TR-73U  
unit via USB cable. If the setting is ON, the Quick Start Program will 
periodically communicate with the device driver and upon the detection of a 
USB connection will open the main software program.
For more details about [Quick Start] and how to quit it, see P.7.

	. Place a check next to [Upon connecting a Thermo Recorder, open the 
Software Program].
With no checkmark: Quick Start will be disabled  
With a checkmark: Quick Start will be enabled

2. Click [OK] to complete the setting.

Temp. Unit to be displayed in Software Program
Select whether to use Celsius or Fahrenheit as the displayed unit of 
temperature when monitoring current readings and using the adjustment 
function.

	. Check either unit of temperature (Celsius or Fahrenheit).

2. Click [OK] to complete the setting.

3. After completing settings, please close the TR-73U program and 
reopen it to make settings effective.
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Basic Function for TR-5i Series
TR-51i/52i/55i: Starting Recording
Connect the Data Logger you wish to make settings for to your computer. 
For details about connecting to your computer, see P.11.

[Start Recording] Tab
IMPORTANT:
- If the computer system clock is incorrect, a programmed recording start may not 

start properly. Please make sure that your computer clock settings are correct.
- By starting a new recording session, all stored data will be deleted from the device.

Recording Start Method
Selections from: Programmed Start / Immediate Start.
Programmed Start: Recording will start on the specified date and time. 
Immediate Start:  Recording will start immediately upon completion of 

  settings. 
Recording Interval 
Select from: 1, 2, 5, 10, 15, 20, 30 seconds 1, 2, 5, 10, 15, 20, 30, 60 minutes
 (Default setting is 10 min.) 

Recording Mode
One-time:   Upon reaching the storage capacity of 16,000 readings, the 

word [FULL] will appear on the LCD display and recording will 
automatically stop. 

Endless:   Upon reaching the storage capacity of 16,000 readings, the 
oldest data is overwritten and recording continues. 

The estimated finish date and time of recording in One-time mode will be automatically 
calculated from the set recording interval and starting time. 

Channel Name
By placing a check in the [Set] box, you can enter a channel name with up to 
8 characters. 

Unit of Temperature 
Selections from: Celsius (ºC) or Fahrenheit (ºF) .
Change the display of temperature on the data logger between ºC and ºF.

Infrared Comm.
Forbid:  Infrared Communication will not be possible. 
Permit:  Infrared Communication will be possible. 

- If you are using TR-57DCi (Discontinued) and do not wish to use infrared 
communication, we suggest selecting “Forbid”. (Battery life will be longer.) 

- Forbid / Permit settings for infrared communication can also be made from [Infrared 
Communication Settings] in the [Communication] menu.

[Start Recording] Button
Use this button to send the settings to the data logger and start recording. 
Once the recording has started, disconnect the device from the PC and place 
it at the measurement location.

[Receive Settings] Button 
Use this button to read the settings from the connected Logger. 

[Stop Recording] Button 
Use this button to stop recording. 

[Warning Settings] Button (TR-51i/52i)
Use this button to make warning settings on the TR-51i or TR-52i. (See 
P.25). 

[Detailed Settings] Button (TR-55i)
Use this button to configure the TR-55i detailed settings such as the 
sensor type, recording method, etc. (See P.26) 
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TR-51i/52i/55i: Downloading Recorded Data 
Connect the logger to your computer to download the recorded data. If 
the warning LED flashes on the device, you can check when the warning 
was issued.
For details about connecting to your computer, see P.11.

[Download Recorded Data] Tab
IMPORTANT:

Before making Downloading Data make sure that your computer clock settings are 
correct. If your computer’s clock is not correct, it will effect the date and time of the 
data being downloaded. 

[Download] Button
Click the [Download] button to start downloading.  
If necessary, you can specify the range of data to be downloaded by checking 
the [Specify Data by time] checkbox.

[Detailed Settings] Button
Settings can be made for the data processing method after downloading. 

After downloading, automatically show graph.
Downloaded data will be automatically saved into a file, and the graph 
will appear.
File names cannot be specified.
After downloading, specify file in which to save data.
The [Save File] dialog box will appear after downloading, where you 
can assign a name to the file to be saved.
Graph will not be displayed.
After downloading, specify file name and automatically show graph.
Downloaded data will be saved into a specified file, which can then be 
automatically viewed in graph form. 
Automatically save file.
Downloaded data will be automatically saved into a specified folder. 
Click the [Browse for Folder] button to select the folder you wish to 
save the data into.
If the folder has not been specified, the file will automatically be stored 
to the same folder into which the application was installed.

[Warning Times] Button
Check the warning occurrence time of the device with the warning LED 
indication. (See P.29) 

TR-51i/52i: Warning Monitoring Settings 
By clicking the [Warning Settings] button in the [Start Recording] tab, the 
settings window will appear. Place a check in the [Set Limits] box after 
entering the Upper and Lower Limits and the Judgment Time. 
IMPORTANT:

If these settings are made in an environment where one of the limits is being exceeded 
and recording is started, the monitoring function will enter “wait” mode. Once a 
measurement returns to within the set limits, the monitoring function will begin to 
operate. 

Upper Limit / Lower Limit
The Upper / Lower Limits can be set in a range from -60 ºC to 155 ºC. 
When you wish to change the unit of temperature, go to the [Settings] Menu, 
open the [Software Settings], and edit temp. unit. 

Judgment Time
Selections from: 10, 15, 20, 30 seconds or 1, 2, 5, 10, 15, 20, 30, 60 minutes.
A warning occurs when a measurement exceeds one of the set Upper / Lower 
Limits for longer than the time set as the Judgment Time. The warning LED 
will flash and a warning message will appear on the LCD screen. 
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TR-55i: Detailed settings and Warning 
Monitoring Settings
The [Detailed Settings for Recording Start] window will appear with 
different setting items depending on the measurement item. 
After having made the necessary settings, click the [OK] button. You will 
be returned to the [Start Recording] Tab Window. By clicking the [Start 
Recording] button, the settings will be transmitted to the Data Logger.

Sensor Type (TR-55i-TC / 55i-Pt)
Select the type of sensor to be used for the measurement.
When you replace with a different type of sensor, make sure to change this 
setting before starting the measurement/recording.

Recording Method (TR-55i-V / 55i-mA)
Select the recording method to be used by the Data Logger.
Instantaneous Value:  
  Records the instantaneous value at the set recording interval.
Average Value:  
  Records the value as the average of the measurements taken 

during the set recording interval.
Measurement Range (TR-55i-V)
Select the range to be used for measurement and in the display of the Data 
Logger.
  V:   Measurement range for the Input Module is set to V Range. 

The LCD for the TR-55i-V can display from 0.000V to 22.00V 
(auto decimal point).

  mV:   Measurement range for the Input Module is automatically 
switched from "mV Range" to "V Range" depending on the 
measurement. Input voltage range in the TR-55i-V LCD is 
0.0mV to 999.9mV (fixed decimal point).

Preheat / Preheat Time (TR-55i-V) 
Select whether to use the preheat function or not. For details about the 
preheat function, see below. When using the preheat function, make settings 
for the length of time to send current to the sensor. See below for details.

What is the Preheat Function?
Preheat is a function which allows the Data Logger to control power to 
the connected sensor. It transmits a preheat signal that is synchronized 
with the recording interval to turn sensors ON before and OFF after 
measuring and recording.

What is the Preheat Time?
When using the preheat function, this stands for the length of time to 
send current to the sensor before measurement and recording is set 
to occur. Setting the preheat time to a value that is equivalent to or 
longer than the recording interval will supply current to the sensor at 
all times.

Measure and Record

Preheat Time Preheat Time

Current to 
Sensor

Measure and Record

OFF OFF OFFON ON

IMPORTANT:
- When using the preheat function, the LCD display will be refreshed based on the 

recording interval set in the Data Logger (because sensors only carry out 
measurement at the set recording time).

- The necessary preheat time varies depending upon the sensor to be used; please 
check the specifications of the sensor before making settings for the preheat time.

Pulse Signal Type (TR-55i-P)
Make settings for the pulse signal type to be recorded.
  Rising:   Records the number of rising pulses during the set recording 

interval.
  Falling:   Records the number of falling pulses during the set recording 

interval.
LCD Display (TR-55i-P)
Make settings for the display method for what value is to be shown in the LCD 
of the Data Logger.
Pulse Rate:  Displays the most recent pulse count in the amount of time set 

as the recording interval. The display will be refreshed every 
one-sixtieth of the recording interval. (When the recording 
interval is less than one minute, the refresh interval will be one 
second.)

Total Pulse Count: 
  Displays the cumulative number of pulses from 0 to 9999. The 

displayed count will be refreshed every one second, and upon 
exceeding 9999, the count will start over again from 0.

Chattering Filter (TR-55i-P)
Select whether or not to use the filter circuit for the chattering which occurs 
due to changes in polarity.
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Warning Monitoring 
The setting items vary depending upon the measurement item. 
If these settings are made in an environment where one of the limits is being 
exceeded and recording is started, the monitoring function will enter “wait” 
mode. Once a measurement returns to within the set limits, the monitoring 
function will begin to operate.

Upper Limit / Lower Limit
The possible setting range varies for each sensor. If the entered value 
is outside the acceptable range, a warning message will appear.
Warning Judgment Time
Selections from: 10, 30 sec. or 1, 2, 5, 10, 15, 20, 30, 45, 60 min.
A warning occurs when a measurement exceeds one of the set Upper / 
Lower Limits for longer than the set Judgment Time. The warning LED 
will flash and a warning mark will appear on the LCD screen.
Target Item for Warning Monitoring (TR-55i-P)
Select the target item from Pulse or Event (rising or falling) and 
Judgment time for warning monitoring.
For Pulse For Event
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Time Time

Warning Issued Warning Issued

Falling

Judgment 
Time

Judgment 
Time

Recording Interval

Upper 
Limit

TR-51i/52i/55i: Checking and Clearing Warning
By clicking the [Warning Time] button in the [Download Recorded Data] 
tab, the Warning Time window will appear where you can check the time 
of the warning or clear the warning.
The Warning Time window can also be opened from the [Communication] menu.

IMPORTANT:

Even if more than one warning occurred, only the first one will be shown in the most 
recent list.

[Receive most recent time] Button
It is possible to check warning times in the [Warning Occurrence Times] 
Column. 

[Clear Occurrence Times from Main Unit] button 
It is possible to complete the removal. 

The warning LED can also be cleared by downloading the recorded data 
or by starting recording on the device.
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TR-51i/52i/55i: Adjustment Settings
Adjustment is a function used to make adjustments to Remote Unit 
measurements. By making adjustments to measurements, the adjusted 
measurements will be displayed and recorded. 

IMPORTANT:
- We cannot guarantee that after carrying out adjustment the measurement, accuracy 

will improve for all measuring ranges. 
- If you remove a sensor that was connected when adjustment was carried out and 

then connect a different sensor, make sure to make new adjustment settings to 
reflect the actual situation. 

- When making “Adjustment Settings” for the TR-55i, the adjustment values will be 
saved to the Input Module. Therefore, when an Input Module is replaced, it is 
necessary to re-make any desired adjustment settings to be written into the newly 
connected module.

- If new adjustment settings are made on already adjusted values, the probability of 
measurement errors will increase. Make sure to click the [Initialize] button before 
making any new adjustment settings on already adjusted values. 

- When you are carrying out adjustments and formulating equations, please take care 
with the settings and take personal responsibility for the process. 

	. Connect the Data Logger to your computer. (See P.11) 

2. In the [Communication] Menu, click [Adjustment Settings] to open 
the settings window. 

3. Check the Method of Adjustment: [1 Point Adjustment] or [2 Point 
Adjustment]. 
1 Point Adjustment: Use when measuring in a range of ±20ºC. 
2 Point Adjustment: Use when measuring in a wide range.

	. Enter the actual measurement before adjustment in the [Before] box 
and the desired measurement after adjustment in the [After] box. 
For “Adjustment Guidelines”, see p.34.

5. By clicking the [Send Settings] button, a confirmation message will 
appear. Then click the [OK] button to transmit the adjustment 
settings. 

[Initialize] Button
Clears any previous adjustment equation(s) and initializes the device. 

[History] Column 
The latest 4 adjustment history records will be displayed. The records show 
the date and time that adjustment settings were made, the adjustment 
point(s), and the values for “Before” and “After” adjustment. 

TR-55i-V/mA/P: Scale Conversion 
Settings can be made here when measuring Voltage, 4-20mA, or Pulse 
with the TR-55i.
This is the equation to be used for scale conversion. If desired, a string of 
characters can be input directly to show the "Unit of Measurement" for 
the value after scale conversion.
Connect the device to your computer and open [Scale Conversion] from 
the [Communication] menu.
IMPORTANT:

The TR-55i LCD will not reflect changes in the value or unit of measurement after 
conversion.

Convert by using the equation: y=ax+b
Select this when the values for both the slope (a) and intercept (b) for the 
conversion equation are already known.
Enter these values in the equation where "x" is the actual input value (in V, 
m-A, or Pulse) from the sensor and "y" is the result of the conversion (in the 
specified unit).
IMPORTANT:

Make sure that the slope and intercept are values between –9,999 and +9,999. It is 
possible to enter decimals or minus values, but "zero" cannot be entered as the slope.

Convert by specifying 2 points:
Select this when both the input values from the sensor (in V, m-A, or Pulse) 
and the post-conversion values (in the specified unit) are known at two points. 
Please make settings after having consulted your sensor manual for details.

IMPORTANT:
- Make sure to enter values for the two points so that the slope and the y-intercept of 

the conversion equation fall within the range of –9999 to +9999.
- It is possible to enter decimals or minus values, but the slope cannot be zero. Also, 

make sure to make settings such that the value for "y" will fall between –80,000 and + 
80,000.
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TR-51i/52i/55i: Software Settings

[Settings] Menu
Upon Connecting a Thermo Recorder, open the Software Program
This setting opens the software program upon the connection of a 
TR-51i/52i/55i  unit via USB cable. If the setting is ON, the Quick Start 
Program will periodically communicate with the device driver and upon the 
detection of a USB connection will open the main software program.
Place a check next to [Upon Connecting a Thermo Recorder, open the 
Software Program].
 With no checkmark: Quick Start will be disabled 
 With a checkmark:   Quick Start will be enabled
For more details about [Quick Start] and how to quit it, see P.7.

Temp. Unit to be displayed in Software Program
Select whether to use Celsius or Fahrenheit as the displayed unit of 
temperature when monitoring current readings and using the adjustment 
function.
After completing settings, please close the TR-51i/52i/55i program and reopen 
it to make settings effective.

Up to 8 channels of data can be viewed in the same graph window. 
Moreover, if you save the graph window using “Save As” command, it is 
possible to save multiple sets of data into one file. 

If you want to display more than 8 channels of data or temperature/humidity/voltage/
pulse data in the same graph, install the T&D Graph software.

Graph
T&D Graph 
T&D Graph is a Windows software that can be downloaded from T&D 
Website and used in place of Temperature / Humidity Graph and 
Multi-scale Graph. It contains a variety of useful functions including the 
ability to read, merge, display, and save multiple recorded data files 
regardless of the model*.

 * Note: RVR-52 event data is not supported.

Download
https://tandd.com/software/td-graph.html

For details about the functions and operations of T&D Graph, refer to 
the Help below.
T&D Graph Help
https://cdn.tandd.co.jp/glb/html_help/tdgraph-help-eng/

Other Graphing Tools
The following graphing tools are included in the “T&D Recorder 
forWindows (TR-5,7xU)” software.
For details about their functions and operations, refer to the Help for 
each tool. (Open the target tool and click Help in the menu bar.)

Temperature / Humidity Graph 
For viewing a graph of the downloaded temperature, humidity and Barometric-
Pressure  data.

Multi-scale Graph 
It can display graph channels with different scales simultaneously. 
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Other
Adjustment Guidelines 
By setting adjustment values beforehand, you can record and display the 
post- adjusted measurement values. You can choose from two 
adjustment methods: 1-point and 2-point. Adjustment will be carried out 
using an adjustment equation of y=ax+b; where x is the pre-adjusted 
measurement value and y is the post-adjusted value.

	 Point Adjustment
This adjustment method changes only the offset (b) where the slope (a) is 
considered 1. 
For example, the Data Logger is measuring 10 ºC, but the standard says 
the actual measurement should be 10.2 ºC. Enter 10 in the Before 
Adjustment box and 10.2 in the After Adjustment box. The conversion 
equation will be y=x+0.2 and for all measurements an adjustment to the 
offset of +0.2 will be made. 

Displayed Temp
(°C)

Actual Temp (°C)

Post-Adjusted Reading

Current Reading
(Pre-Adjusted Reading)

Post-adjustment
temp characteristic 

2 Point Adjustment
The adjustment equation will be calculated from two points: the slope (a) 
and the offset(b).
For example, the Data Logger reads 0 ºC when the standard thermometer 
reads 0.4 ºC, and Data Logger reads 10 ºC when the standard says the 
true measurement is 10.2 ºC. In this case the slope(a)is 10.2-0.4-10-
0=0.98. The offset is 0.4, so the conversion equation becomes 
y=0.98x+0.4. The range of the slope is 0 < a  2. Entries are valid to one 
decimal point, but after calculation up to four digits are valid for the 
slope and offset.

Displayed Temp
(°C)

Actual Temp (°C)

Post-adjustment
temp characteristic 

Current Reading
(Pre-Adjusted Reading)

Current Reading
(Pre-Adjusted Reading)

Post-Adjusted Reading

Post-Adjusted Reading

Adjustment Entries
The adjustment equation (y=ax+b) is determined by the adjustment 
entries. An equation with a slope (a) and/or an intercept (b) exceeding the 
following ranges cannot be set.

Temp-Humidity Voltage 4-20mA

Slope (a)
Range 0 < a  2

Significant Digits 4 decimal places

Intercept 
(b)

Range within ±30 °C
within±30 % within ±3 V within ±30 mA

Significant Digits same as that of the data logger's measurement 
resolution
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Troubleshooting

: Q The date and the time of the recorded data are different from 
the actual date and time of recording. Why?

A: The Thermo Recorder has no internal clock. When you set up a 
programmed recording start or when you download data, the date 
and time that are shown are taken from your computer's clock. If your 
computer's clock is not correct, it will affect the recorded data.

 When recording mode has been set to [Endless] and Recording Start 
was carried out via PC, the time for recorded data is calculated from 
the recording start date and time and will appear correctly in the 
Graph as long as recording capacity has not reached its limit. 
However, once data capacity has become full and the oldest data is 
overwritten, the date and time for downloaded data in the Graph will 
be calculated using the PC's clock for the latest recorded data and 
subtracting backward. Hence the time for the displayed data will be 
different from the actual time the data was recorded.

: Q I installed T&D Graph, but the downloaded file is associated 
with another program and cannot be opened with T&D 
Graph. What should I do?

A: Follow the steps below to change file associations.

	.  In the data storage location, right-click on the graph file (.trz) 
and select [Properties].

2.  In the General tab of the Properties window, click the [Change] 
button.

3.  Select "T&D Graph" from the list that appears and click [OK].
If "T&D Graph" is not in the list, select "TandDGraph.exe" in the 
installation folder. 
Default Installation Folder: C:\Program Files (x86)\T&D Graph   

 Caution:
 For TR-73U, the recorded data cannot be automatically opened in T&D 

Graph even if you change file associations.
 In the [Download Recorded Data] tab - [Detailed Settings] menu of 

this software, remove the checkmark for “After downloading, 
automatically display graph”. Then use one of the following methods 

to open data in T&D Graph.
• Double-click the file directly in the storage folder on your computer.
• After opening T&D Graph, select the desired file from the [File] menu.
• After opening T&D Graph, drag and drop the file into the graph display 

area.



Product Support
For support, please contact the distributor from which you purchased the 

product.
A list of distributors can be found at:
https://tandd.com/purchasing/
Product Information
Product information can be found at:
https://tandd.com/product/


